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Scope of work L/

» This document explains how to set up and use the CYT4BF evaluation kit, which mounts the
CYT4BFBCH device. It also describes debugging with single-core and multi-core applications in
the ModusToolbox™ (MTB) environment.

» ModusToolbox™ tools package version
- 3.0.0

» Device

- The TRAVEO™ T2G CYT4BFBCH device is used in this code example.
» Board
— The TRAVEO™ T2G KIT_T2G-B-H_EVK board is used for testing.
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Getting started &/

» This section explains the hardware setup. The following table lists the prerequisites for the setup.

Quantity

1 KIT_T2G-B-H_EVK CYT4BF evaluation kit

1 Micro USB cable For power and communication
1 PC With USB port

1 ModusToolbox 3.0 Downloaded from the web
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Getting started (contd.)
» Connection setup

— Connect the USB cable from the PC to the evaluation kit. The PC powers the evaluation kit via
the USB cable (5V).
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;

ModusToolbox™ setup

> Launch ModusToolbox™
— The Eclipse IDE is installed in the following directory by default:
<install _path>\ModusToolbox\ide <version>\eclipse\
— To launch the Eclipse IDE:

—On Windows, select the Eclipse IDE for ModusToolbox™ <version> item from the Start
menu

— For other operating systems, run the "modustoolbox" executable file

— When launching the Eclipse IDE, there is an option to select the workspace location on your
machine. This location is used by the IDE for creating and storing the files as part of application
creation for a particular platform. The default workspace location is a folder called "mtw" in your
home directory. You may add additional folders under the "mtw" folder or to choose any other
location for each workspace.

— For more details about Eclipse, see the Eclipse documentation and the Eclipse survival guide.
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ModusToolbox™ setup (contd.)

» Create an application
» Choose the board support package (BSP)
— To choose the BSP, do one of these:

— Click the New Application link in the Eclipse
IDE Quick Panel

— Select File > New > ModusToolbox™
Application

B Q. =V.. SE. @gB.. =

Eclipse IDE for
ModusToolbox™

~ Start

I : Mew Application I
E Import Application
d” Search Online for Code Examples

P Search Online for Libraries and BSPs

& Training Material
&, Refresh Quick Panel
» Project

» Launches

» Tools

» Documentation

=

(infineon

m hw - Hello_World/README.md - Eclipse IDE for ModusToolbox™

File Edit MNavigate Search Project Run Window Help
AltsShift+N > ™ Project..

New
Open File..,
[} Open Projects from File System...

Recent Files

X m ModusToolbox™ Application  Ctrl+7

Ctrl+M
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ModusToolbox™ setup (contd.) &-/

— These commands launch the Project Creator tool, which provides several applications for use with
different development kits, and the kits available may change over time. This example uses the
KIT_T2G-B-H_EVK Kkit.

& Choose Board Support Package (BSP) - Project Creator 2.0 hd

Settings Help

Source Template

text Browse.. | = [+ | KIT T26-B-H EVK °
Kit Name MCU/SOC/SIP Connectivity The KIT_T2G-B-H_EVK, a 272-pin evaluation board is based on the TRAVEQ™ T2G
~ TRAVEO™ BSPs family of devices. TRAVEQ™ T2G MCU is designed for industrial applications. The

KIT T2G-B-H EVK CYT4BFBCHE <nones evaluation board carries a TRAVEQ™ T2G microcontroller, a M.2 interface connector

for interfacing radio modules based on AIROC™ Wi-Fi and Bluetooth® combos
(currently not supported), SMIF dual header compatible with Digilent Pmod for
interfacing HYPERBUS™ memories (currently not supported), and headers
compatible with Arduino for interfacing Arduine shields. In addition, the board
features an on-board programmer/debugger (KitProg3), a 512-Mbit QSPI NOR
flash, CAN FD transceiver, Gigabit Ethernet PHY transceiver with RJ45 connector
interface, a micro-B connector for USB device interface, three user LEDs, one
potentiometer, and two push buttons. The board supports operating voltages from
3.3 Vto 5.0 V for TRAVEQ™ T2G device.

Kit Features: v

o gy v g
Summary:
BSP: KIT_T2G-B-H_EVK

Press "Next" to select annlication. ¥

Next > Close

e
— For more details about using this tool, see the Project Creator user quide
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ModusToolbox™ setup (contd.) &-/

» Select application

— Onthe Choose Board Support Package (BSP) — Project Creator 2.0 window, click Next > to open the Select
Application page

— This page lists various applications available for the selected kit. As you choose an application, a description displays on
the right. You can select multiple applications for the selected BSP by enabling the check box next for those applicable.

[ Select Application - Project Creator 2.0 - a ®
Settings  Help
Application(s) Root Path: |C:/Users/UmenoKazuo/mtw Browse...
y For th |S exam p | e: Target IDE: Eclipse IDE for ModusToolbox™
— Select the check box next to the "Hello B Y B B B e e e
World" application and "Multicore Empty T.,emii:::z‘::;j;n e pplestentiame For more details, see the README on GitHub.
APP" application iR sy
— If desired, type a name for the application 2 MalcorsEnpry A o Enpty Aop
under New Application Name. Do not use 1000 008 Do
spaces in the application name. In this e
case, we use the default "Hello_World" and = ssmmetie s Generstion = -
"Mu|ticore_Empty_App" as the name. Template Application(s): Hello World, Multicore Empty App

Application(s) Root Path: C:/Users/UmenoKazuo/mtw

Press "Create” to create the selected application(s).

< Back Create Close

o
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ModusToolbox™ setup (contd.)

» Create application

— Click Create to begin the project creation process.

BSP: KIT_T2G-B-H_EVK
Template Application(s): Hello World, Multicore Empty App
Application(s) Root Path: C:/Users/UmencKazuo/mtw

Press "Create" to create the selected application(s).

< Back

Create

Close

(infineon

- When complete, the Project Creator tool closes automatically. After several moments, the application opens with the

~ XMC7000: Multi-core application template i

Requirements

i
+ ModusToolbox&irade. software v3.0 or later (tested with v3.0)
- . g language:
= Associated pars: XMC7000 MCU
Eclipse 1DE for
lodusTor - - -
Meodustoslbox Supported toolchains (make variable "TOOLCHAIN")

mbedded compiler 1031 ( ) - Default value of
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;

Download and debug with evaluation kit

» The following types of applications are created:

— Single core application (Hello_World):

— This application contains the prebuilt CMO+ image, and the main application function runs on the CM7_0 core. The
prebuilt CMOP image only starts CM7 cores and puts CMO+ core into Deep Sleep mode.

— For details on the prebuilt CMO+ image, please refer to CAT1 Cortex MO+ prebuilt images.

— Multi-core application (Multicore_Empty_App):
— This application contains the CMO+ project, CM7_0 project, and CM7_1 project.

— CMO+ and CM7 can do normal code execution, but from an architectural point, only CM7 is considered the application
core (CM7 cores for primary processing and CMO+ core for peripheral and security processing). After a reset, the
default core is always the CMO+ core. To enable the CM7 core, CMO+ must call Cy_SysEnableCM7().
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Download and debug with evaluation kit (contd.)

» Debugging with single core application:
1- BUiId the applicatlon [ mtw - Hello_World/main.c - Eclipse IDE for ModusToolbox™ - o x

File Edit Source Refactor Navigate Search Project Run Window Help

. . . O-EGl®-4-ai0 : [S 2| &i%-0-Q-i® s~ - E- -t Q el@

—a) Select the Hello_World project in the Project =« we vx e -0 cmoe o e g o
Explorer window and click on the Build "o o

Hello_World Application shortcut under the = AR Cm

e release-v400

Hello_World group in the Quick Panel. It selects & e

& Makefile

the Debug build configuration and compiles/links | ..z

15 Multicore_Empty_App

all projects that constitute the application. Zow ww e me

~ Hello World (APP_KIT XMC72_EVK) S

te of Cypress Semiconduct isr_timer(void”, cyhal_tim
timer_interrupt_flag : boc|
led blink_active flag : bo|
uart_read_value: uinta_t
led_blink timer : cyhal tif
main(void) : int
timer_init(void) : void
isr_timer{void®, cyhal tim

coo®® PO T THERE

uit p An

—b) The Console view lists the results of the build L :
. . . & Console 53 (2] Problems SgProgress [] Memory 8 Terminal CoB BE-&lMmB-8-=0
operation, as the following figure shows. o s | A
| -heap | exzseaizsc | 3saaze |
—If you encounter errors, revisit previous steps to v o g gt e
ensure that you accomplished all the required — s s S8 (R vy S
tasks. i TSR R v

125 Hello_World
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Download and debug with evaluation kit (contd.)

2. Debug the application:
The CYT4BF evaluation kit has a KitProg3 el M- o oo™ — 0 ~x

File Edit Seurce Refactor Navigate Search Project Run Window Help

onboard programmer/debugger. It supports ST ST 2212i%-0-Q-im - -F-eoc-o-m o sl

) EyP. 32 #D. HiR. TP. = O .READMEmd [¥] README.md [g) main.c &2 = O g Outline 32 =g
Cortex® Microcontroller Software Interface o ROV S T m— N EREEA
Standard - Debug Access Port (CMSIS-DAP). | == o T
See the KitProg3 user guide for details. e ¢ o

] mainc

— ModusToolbox™ software uses the OpenOCD | i

README.md

protocol to program and debug applications on | &,
the CYT4BF MCU devices. ModusToolbox™ |z o we e 20

software will identify the device on the kit only | <o

f Clean Hello_World Application

if the kit is running KitProg3. R e———— ss@@a-a=e-o-"s

ncluding source code, documentation and related
miconductor Corpor
s protected by and subject t
and foreign),

led_blink_active_flag : boy
uart_read_value : uintd_t
ed_blink_timer: cyhal_tir
main(void) : int

#

#

#

£+

@ timer_intemupt flag : boo
®

@

.

0

© timer_init(void) : void
®

S isr_timer{void*, cyhal_tim|

compilation, or representatis

%5 Hello_World Debug (ILink) ~
Prebuild cperations complete
I th . k P I I k th I I W I d [ 3 Hen d Debug (KitProg3_MiniProgd]  Commencing build operations
n e Qu I C an e ) C IC e I Ie O Or © Hello_Warld Pragram (ILink) Tools Directory: C:/Users/zusdavid/ModusToolbox/tosls_3.0
© Hello_Werld Program (KitProg3_MiniProg

De b g (K i t P r 0 g ) I i n k nder a. n C h eS Generate Launches for Hello_World e
| I 3 | I I l I &, Generate Launches for Hello_World
. !

v Tools
Library M " Constructing build rules
I Library Manager 20 Build rules construction complete

& Device Configurator 4.0 (new configuratio
B Auto-discovery in progress
[ Device Firmware Update Host Tool 1.60 Auto-discovery complete
2] ACBI Cmimeraine A1) v v
< > ||« >

‘ Launching Hello_World ...niProg4): (4%) [ 1=
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Download and debug with evaluation kit (contd.)

If needed, the IDE builds the application, and messages display in the Console. If the build is
successful, the IDE switches to debug mode automatically, as the following figure shows.

- If you Want to open the disassembly WlndOW click Window > Show View > Disassembly.

Eclipse IDE for ModusToolbox™

Vindow Help
LIt O Qi@ o B Gl ~Selee Q el E(SHFJGRHW
READMEMS ) manc 22 [T]0QM 2 Outine =

o 2in M3 New Window Qi
Edit >
| G > ¢ Emanc [EoRla
> O Breaskpoints Ale+Shift+Q, B
- Perspective > B Console AltsShift+Q, C
/* In
cal Navigat
7% B b Alt+Shift+Q, L
! l l-d al s d l-eou ————————————
w’ ’"' gt s e if (result I= CY_RSLT_SUCCE 4
CY_ASSERT(0);
ble global int Alt+Shift+Q, O
ble_irq();
Initialize retar Alt+Shift+Q, X
Memory $# Termi - e~ o 1t = cy_retarget_:
194) [GDB OpenCD Debugging]
/* retarget-io init failed. |t Registers
if (re l‘t 1= CY_RSLT_ SU((E o
| Tasks
CY_ASSERT(8); ()= Variables Alt+Shift+Q, V
Other... Alt+Shift+Q, Q
I e

..............

Wiitable Smart insert 100:38: 2229

3. Click the Resume icon or press the F8 to start execution. LED1 should start blinking.

LED1

— You can also use the function keys in the Debug window: Resume (F8), Step Into (F5), Step Over (F6), Terminate
(Ctrl+F2).
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Download and debug with evaluation kit (contd.)

» Debugging with multi-core application:
1. Build the multi-core application

— a) In the Project Explorer window, click the
Multicore_Empty_App project.

— b) Click on the Build Multicore_Empty_App
Application shortcut under the
Multicore_Empty_App group in the Quick
Panel. It selects the Debug build configuration
and compiles/links all projects that constitute the

application.

— ¢) The Console view lists the results of the build
operation, as the following figure shows.

- If you have selected Multicore_Empty_App, you
can also select Build Project from the Project

menu or the right-click menu.
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[ mtw - Multicore_Empty_App/README.md - Eclipse IDE for ModusTeolbox™

File Edit Mavigate Search Project Run Window Help

imid | ®-/- & B

{4y Proj.. B8 45 Deb.. N Regi. B, Per. =
7 4

2 Hello_World
<

= mib shared
=5 Multicore_Empty_App

=

G releasev400

a

(£ Mutticore_Empty_App.praj_cmOp (in proj_cm0p

(2% Mutticore_Empty_App.proj_cm7_0 (i
(22 Multicore_Empty_App.proj_cm7_1 (in pr
4 Binaries

& common_spp.mk

& common.mk

= LICENSE

& Makefile

[¥ README.md

=2 2i%-0-U-id - B e G

READMEmd 57

- a X

leie Q iEE

= B 5= Outline 53 = B8

XMC7000: Multi-core application prototype

This is a minimal starter multi-core application template for XMC7000 devices

View this README on GitHub.

i Provide feedback on this code example

Requirements

» ModusToolbox&trade; software v3.0 or later (tested with v3.0)

* Programming language: C

+ Associated parts: XMC7000 MCU

[ Quic.. (-Varia.. % Expr.. 9 Brea. = [ Markdown Source | Preview

Eclipse IDE for
ModusToolbox™
» Start

+ Multicore_Empty_App

|6g Build Mutticors_Empty_App Application

9 Clean Multicore Empty_App Application
+ Launches

& Multicore_Empty_App Debug MultiCare (Link)

. Mutticore_Empty_App Debug MultiCere (KitProg3_

& Generate Launches for Multicore_Empty_App

<

>

(N ~ h1. XMC7000: Multi-core
h2. Requirements
h2. Supperted toolcha
h2. Supperted kits (mq
h2. Harchware setup
h2. Software setup
h2. Using the code exi
h2. Operation
h2. Debugging
~ h2. Design and impler|
h3. Folder structure

& Console 52 [&] Problems =g Progress [] Memory & Terminal
| COTBuild Console [Multicors_Empty_App]

| -noinit | ex28080100
| .bss | ex2388@194
| .heap | ex23e80a94

Total Internal Flash (Available)
Total Internal Flash (Utilized)

Total Internal SRAM (Available)

Total Internal SRAM (Utilized with heap)

make[1]: Leaving directory '/cygdrive/c/Users/zuodavid/mtw/Multicore_Empty_App/proj_cm7_1'

& ¢ &l & &R

148 |
2304
517484 |

8585216
3456

1048576
520192

15:48:45 Build Finished. @ errors, @ warnings. (took 3m:28s.188ms)

X Bt =B

<
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Download and debug with evaluation kit (contd.)

2. In the Quick Panel, click the

Multicore_Empty_App MultiCore (KitProg3)
. (& mtw - Multicore_Empty_App.proj_cmOp/main.c - Eclipse IDE for ModusToolbox™ — [m] X
Iln k u nde r L au n C h eS . File Edit Source Refactor Navigate Search Project Run  Window Help

[ [®~-& -G (22| & H-0-Q-i® -} iH-EroPo-or M Qi
[{5 Proj.. 52 45 Deb.. ¥ Regi. F Peri. = O [&] READMEmd [€ main.c 52 [g main.c [§] main.c = B0 Z=outine s = O
BE% YV & AleBRkR e
<
12 Hello_World 2 #include "cy pdl.h” *
5 mth_shared 2 #include 8
w25 Multicore Empty_App 2 #include ;
: i " cy_pdlh
(& bsps 3 #include "cybsp.h o
(g releaseva.0.0 [ihag.‘h
b: Multicore_Empty_App. pmj.;mep (in proj_c #define CM7_DUAL 3 cybsp.h
(=5 Mutticore_Empty_App.proj_em7.0 {in pro CMT DUAL

2% Mutticore_Empty_App.proj_cm7_1 (in proj_cm7_
#% Binaries

= int main(void) main(void) : int

[ common_app.mk init_cycfg_all();
u

commonmk /* enable interrupts */
Lo . __enable_irq();
| & Makefile /* Enable CM7_@/1. CY_CORTEX_M7_APPL_ADDR is calculated in linker script, ¢
README.md Cy_SysEnableC7 (CORE_CM7_@, CY_CORTEX_M7_8_APPL_ADDR);

Cy_SysLib_Delay(1680); /> To avoid race between CM7's while initializing th

#if CM7_DUAL

Cy_SysEnableCH7(CORE_CM7_1, CY_CORTEX_M7_1_APPL_ADDR); ©
[ Quick.. (0= Varia.. &7 Expr.. % Break. = O e >
B Console 52 [2] Problems =g Progress [ Memory (@ Terminal & ¢S GEEE |lmB-g-=8
Ec[ipse IDE for * COTBuild Console [Mutticare_Empty_App]
™ | .noinit | exzseselee | 148 | A
ModusToolbox | .bss | ex2seseiss | 2304 |
| -heap | ex2seseass | 517484 |
bStart e
b Multicore_Empty_ App Total Internal Flash (Available) 8585216
Total Internal Flash (Utilized) 3456
~ Launches
Total Internal SRAM (Available) 1048576

Multicore_Empty_App Debug MultiCore (ILink]
3 Multicore Empty_App Debug MultiCore (Linkl Total Internal SRAM (Utilized with heap) 528192

[ & Mutticore_Empty_App Debug MultiCore (KitProg3_Iv

@ Generste Launches for Multicore Empty_App make[1]: Leaving directory '/cygdrive/c/Users/zuodavid/mtw/Multicore_Empty_App/proj_cm7_1'

~ Tools 16:12:47 Build Finished. @ errors, @ warnings. (took Im:43s.145ms)

&3 Library Manager 2.0
< > < >
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Download and debug with evaluation kit (contd.)

— This will automatically program the CMOP,
CM7_0, and CM7_1 code into the flash
region of respective cores; then, the IDE
switches to debug mode automatically, as
the following figure shows.

— CMOP debug session is started and halted
at the beginning of the main () function,
CM7_0 and CM7_1 debug session started,
and CPU is not yet started in the following
figure.
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[ mtw - Multicore_Empty_App.proj_cmOp/main.c - Eclipse IDE for ModusTaolbox™

File Edit

.
()]

Source Refactor Navigate Search Project Run

(5 Projec... 45 Debug 33 Uik Regist.. 2, Periph.. = O
3 2

=K 15

. Multicore_Empty_App Debug MultiCore (GtProg3 MiniProgd -

[£] <terminated>Multicore_Empty_App.proj_cm7_0 Program (Kit

[£] <terminated>Multicore_Empty_App.proj_cm7_1 Program (Kit

« [2] Multicore_Empty_App.proj_cm0p Debug (KitProg3_MiniProg
~ [ proj_cm0p.elf

~ o Thread #1 1 (Name: Current Execution) [Suspended : Br

= main( et main.c:53 0x 10000222

4 arm-none-eabi-gdb.exe
 [2] Multicore_Empty_App.proj_cm7.0 Add CM7_0 to CMD+ (KitP
~ &2 proj_em7_D.elf
4@ Thread #1 (Running : User Request)
48 arm-none-eabi-gdb.exe
« [2] Multicore_Empty_App.proj_cm7_1 Add CM7_1 to CM7_0 (KitF
~ &2 proj_em_.elf
4@ Thread #1 (Running : User Request)
38 arm-none-eabi-gdb.exe

[#¥] README.md

Window Help
[ - R @i -0~ Q@ - D0 BN DD

| Sl E v
[ mainc

[ maine %2 | [& mainc
#include "cycf;
#include "cyhal.
#include "cybsp.h”

#define CM7_DUAL 1
int main(void)
init_cycfg all();

/* enable interrupts
__enable_irq();

/* Enable @M7_8/1. CY.
Cy_SysEnableCM7 (CORE_
Cy_SysLib_Delay(106@);

#if CM7_DUAL
Cy_SysEnableChM7(CORE_CM7_1, CY_CORTEX_M7_1_APPL_ADDR);
#endif /* CM7_DUAL */

systemCoreClockUpdate();
Cy_SysPm_CpusleepOnExit(true);

for(;;)
< > {
Cy_SysPm_CpuEnterDeepSleep(CY_SYSPM_WAIT_FOR_INTERRUPT);
[ Quick .. (0= Variables & Expres.. 9 Breskp.. = O <
R B Console 32 [2) Problems &g Progress [J Memory 49 Terminal =
- ~ Multicore Empty App.proj_cm0p Debug (KitProg3_MiniProg4) [6DB OpenQCD Debugging]
s (86] Ob (/64T UXZUG00U0 Za040 000
(48) d7 (/64): ©x120200208cE83000
& Multicore_Empty_App Debug MultiCore {JLink) (58) d8 (/64): BxBEBESES000090008
B (51) do (/64): @xeeeepeccalpeeets
# Multicore Empty_App Debug MultiCore (KitProg2 MiniPre (203 410" /621, expovelsozesiosiss
&, Generate Launches for Multicore_Empty_App (53) d11 (/64): Bx0818060008622445
(54) d12 (/64): exeans180000405002
+ Tools (55) d13 (/64): @xc208404c0RE04103
(56) d14 (/64): @x0700EE05A5004280
[ Library Manager 2.0 (57) d15 (/64): Bx1005200017650000
- (58) fpscr (/32): @xe0000000
[ Device Configurator 4.0 (new configuration) Cortex-1 DT registers
2 0spl Canfinuratar 4.0 v
< >

‘Writable Smart Insert 53:1:2521

- o x

Q im=
B g= Outline 3 = B
~ SR

o pdlh
eyctgh

cyhalh
cybsph
CM7_DUAL
main(void) : int

seript, check

ng the cl

>

% eSS +a-0-=0
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Download and debug with evaluation kit (contd.)

3. Place a breakpointin the cybsp init ()
API in the mian.c of CM7_0 core, you can also

. . - E mtw - Multicore_Empty_App.proj_cm7_0/main.c - Eclipse IDE for ModusToolbex™ - a x
place another breakpoint in main.c of CM7_1

Project Run Window Help

. [mif &2 [ B~/ -E@iH~-0-Q-i® ¥~ Bi0 &2 0 | S|SB E vid-~ § G| a ®l|E
core. CM?_O core and CM7_1 core will start ) Projec. 4p.Debug 51 [ffRegit. T, Perpho = n FEmEm  Bmme

2 main.c 5 main.c [£] 0x366 startup_cm0Opl... = 8 = Outline 7 =0
0 % | i

% #include "cy_pdl.h" " Bl R e
executing after being enabled by CMO+ core. 2 meh ko oo et S £t L *

[E] <terminated>Multicore Empty_App.proj_cm7_0 Program (Kt 3 #include "cybsg.h”
[2] <terminated>Multicore_Empty_App.proj_cm7_1 Program (Kit

H  [E] Multicore_Empty_App.proj_cmOp Debug (KitProg3 MiniProge Bl cpdih
You can debug three cores simultaneously VB pn 4o suntntd B o)
" v i Thread #1 1 (Name: Current Execution) (Suspended : Br { 8 _obph

_ cy_rslt_t result;
= main() at main.c:53 0x10000aaa

» To place a breakpoint at the target instruction, g e

~ [£] Multicore_Empty_App.proj_cm7_0 Add CM7_0 to CMO+ (Ki

click the white space between the editor I e

3 arm-none-eabi-gdb.exe

. v [E] Multicore_ Empty_App.proj_cm7_1 Add CM7_1 to CM7_0 (KitF
window (left pane). vE pg e

48 Thread #1 (Running : User Request)

© mainfvoid) : int

fce and| board peripherals

uccesk)

CY_ASSERT(®);

/* Enable global interrupts */
__enable_irq();

for (5;) =
J arm-none-eabi-gdb.exe {
¥
H
< > E
v
[ Quick .. ()=Variables & Expres.. 9 Breakp.. = O
B Console 5[] Problems =g Progress [] Memory 4 Terminal X% xpEEEE 2re-8-=8
R pp——
A Multicore_Empty App.proj_cm0p Debug (KitProg3_MiniProg4) [GDE OpenOCD Debugging]
= et (45) 08 (/D)% OXOUBBOATODONDGL00 A
47) d5 (/64): ©x05111202000c1160

& Mutticore_Empty_App Debug MultiCore (JLink)

48) d6 (/64): ©x2090600245402600
49) d7 (/64): 6x120260268c008600
50) dB (/64): ©x000040dE0B020000
51) d9 (/64): ©x@00000CCOL100040

(

(
& Multicore_Em E
(
(52) d1@ (/64): 0x5000136208108184
(
(
(
(
(
(

ry_App Debug MultiCore (KitPrag3_MiniPre

&, Generate Launches for Multicore_ Empty_App
« Tools 53) d11 (/64): @x0E11006005020445
/64): @x0008100841404000

(
(

[ Library Manager 2.0 55) d13 (/64): @xc2084@4c00004108
(

- 56) d14 (/64): €x8700000805004280

[ Device Configurator 4.0 (new configuration) 57) d15 (/64): Gx0005200617650000

& 08PI Canfinuratar 4.0 v (58) fpscr (/32): exoeeeceen ~
< >

Writable Smart Insert 53:1:2557
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Download and debug with evaluation kit (contd.)

4. Click the Resume icon or press the F8 in the
CMOP project to start execution.

[ mitw - Mutticore_Empty_App.proj cm7_0/main.c - Eclipse IDE for ModusToolbox™

[m] X
ft t File Edit Source Refactor Navigate Search Project Run Window Help
» After executing e R Ty T P Ty e —
C S E b :l_ C 7 CORE CM7 O [¢) Projec... 45 Debug 51 Ui Regist. 2 Periph. = E1  [6READMEmd  [g manc  [gmainc 5 [@ mainc  [£]06365 startup_cmOpl = B Szouine ® = O
y ys na e M ( 4 D%k E e ey pdlh" ) FEE O
—_ — — 73 Multicore_Empty_App Debug MultiCore (KitProgd_ MinProgd 5 yire 108 o EP07d E
CY CORTEX M7 0 APPL ADDR) and ) <ot amcor e oo o g AT S0 .
[T] «terminated>Mutticore_Empty_App.proj_cm7_1 Program (Kit : " oy pdlh
— — —_ — —_  [E] Multicore Empty_App.proj_cmbp Debug (KitProg3_MiniProg: e
bleCM7 71 i pr—
_em0p. B oybsph
Cy SysEnableCM7 (CORE CM , 5 e 11 s o i) Gain s P

i ey_rslt_t result;
5] openocd.exe

CY CORTEX M7 1 APPL ADDR),CM7_0

« [£] Multicore_Empty_App.proj_cm7_0 Add CM7_0 to CME+ (KitP

®  main(void) : int

/* Initialize the device and board peripherals */
| result = cybsp_init();
TF (result T= CV_RSLT_SUCCESS)

~ [ proj_em7_O.eff

core and CM7_1 core will be enabled and the

CY_ASSERT(@);
= main() at main.c:53 010080908

o5 am-none-eabi-gdb.exe

execution will be halted at the very beginning | Tapui/ereraonman

~ ¢ proj_em7_1.elf

/* Enable globsl interrupts */
__enable irq(};

' . . v o Thread #1 1 (Name: Current Execution) (Suspended : Br for (55)
= 0 at .c:50 0x 1028045
of CM7's main () function. e e {

» You can click the Resume icon or pressthe | - I :

[ Quick... (4= Variables &' Expres.. ©g Breakp. =g

F8 in the CM7_0 and CM7_1 project, the @ o s e s Qb s ¢ e S 2 e

Multicore_Empty_App.proj_cmbp Debug (KitProg3_MiniProgd) [GDB OpenOCD Debugging]
+ Launches C o o

>

ab) 04 (/D8] UXOUBEUAEUNBOYD L0

: ~
eXGCUtlon WI” reach the breaprint In the 8 Multicore_Empty_App Debug MultiCore (Link) (:;; j; E;Zig 3132;;533332%33

49) d7 64): 8x120200203cBB3000
& Multicore Empty_App Debug MultiCore (KitPrag3_MiniPrc ) d7 (/64): ox -
51) d9 (/64): PxPPAAAACCE1108640

CM7_0 project and CM7_1 project. You can A

(
(
(
E
~ Tools (53) d11 (/64): 0xDB110000B3826445
(
(
E

50) dB (/64): BxDOGE4B00OOILGEE

now continue to debug the code from CM7 R '

55) d13 (/64): @xc205494c00004108
. 56) d14 (/64): @x@7000RASASAR4250
[ Device Configurator 4.0 (new configuration) 57) di5 {/64): 0xD@@B208017550060

& 0spI Canfiaurator 4.0 58) fpscr (/32): 0x00000000 v
< >
cores.

Writable Srnart Insert 53:1:2557
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Troubleshooting

» Connection troubleshooting
— Error: Evaluation kit is not detected on the target system
— Connect the USB cable that comes with the evaluation kit. Other USB cables may not connect data lines
— Make sure LED D5 is ON (CMSIS-DAP mode). If not, press SW3 to change the KitProg3 device mode

— If LED D5 is ON (CMSIS-DAP mode), change the KitProg3 device mode by pressing SW3. Now LED3 blinks
smoothly. Then try to reconnect the debug session. Later, check if this works independently; stop the debug session
again and switch the KitProg3 device mode to “LED D5 is always ON” (CMSIS-DAP mode)

» Driver troubleshooting
— Error: Driver is not detected on the target system or “KitProg3” is not visible

— For more information on the supported driver, see the KitProg3 user guide

» Debugger troubleshooting
— Error: While programming the XMC7000 device, the CMSIS-DAP device is not found
— Check the USB cable connection and the state of LED3 (LED should be ON for CMSIS-DAP mode)

» Key points

— The prebuilt CM0+ image should be disabled with the multi-core application; you must add the
XMC7xDUAL_CMOP_SLEEP to DISABLE_COMPONENTS for XMC7xxxD device in the project CM7_0 Makefile
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IMPORTANT NOTICE

The information given in this document
shall in no event be regarded as a
guarantee of conditions or
characteristics
(“Beschaffenheitsgarantie”) .

With respect to any examples, hints or
any typical values stated herein and/or
any information regarding the
application of the product, Infineon
Technologies hereby disclaims any and
all warranties and liabilities of any kind,
including without limitation warranties of
non-infringement of intellectual property
rights of any third party.

In addition, any information given in this
document is subject to customer’s
compliance with its obligations stated in
this document and any applicable legal
requirements, norms and standards
concerning customer’s products and any
use of the product of Infineon
Technologies in customer’s applications.

The data contained in this document is
exclusively intended for technically
trained staff. It is the responsibility of
customer’s technical departments to
evaluate the suitability of the product for
the intended application and the
completeness of the product information
given in this document with respect to
such application.

For further information on the product,
technology, delivery terms  and
conditions and prices please contact
your nearest Infineon Technologies
office (www.infineon.com).
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WARNINGS

Due to technical requirements products
may contain dangerous substances. For
information on the types in question
please contact your nearest Infineon
Technologies office.

Except as otherwise explicitly approved
by Infineon Technologies in a written
document signed by authorized
representatives of Infineon
Technologies, Infineon Technologies’
products may not be used in any
applications where a failure of the
product or any consequences of the use
thereof can reasonably be expected to
result in personal injury.
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